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THE SHRDUL WARRIVR STURY

Lo Wang. Master ninja assassin for 20 vears. A shadow warrior,

Shadow warriors are the best of the best, and Lo Wang was the best of the
shadow warriors. Every top company in Japan had a shadow warrior..a protector,
a negotiator, a cleancr.

Lo Wang waorked for Zilla Enterprises, a conglomerate with control in every major A
industry. Too much control. Power corrupts, and Master Zilla's corporation was ’
corrupted to the core. -
Lo Wang discovered Master Zillas demonic scheme o rule Japan, using creatures 4
summoned from the dark side. A man of honor, Lo Wang quit But onc as powerful 8
as Wang cither must be on vour side, or no one’s side. Master Zilla unleashes his cre-
alions for their firsd lest to kil a single man, a shadow warrior., Lo Wang.

SYSTEM REQUIREMENTS

PowerPC Macintosh or compatible.

16 megabytes RAM

55 MB available hard drive space.
256-Lolor monitor or betler.
CD-ROM drive.

System 7.1 or higher, OS8-compatible.



INSTRUATION

. L Close all open windows on your computer.
q- & Place the Shadow Warrior CD in vour CD-ROM drive, .
" 3 Doubledlick on the “Shadow Warrior” CD-ROM icon to open the CD-ROM win.
daw.
4. Double-click on the "Installer” icon to install Shadow Warrior.
5 Follow the on-screen instructions. |
6 You may nced 1o restart your computer after installing Shadow Warrior,

Once the game is installed, you will need to locate i Bouble-click on your comput-
er's hard drive icon to open the hard drive windaw Doubleclick on the folder named
£ Shadow Warrior.” To start a game, double-click on the “Shadow Warrior” applica-
“ bon joon you will find in this folder. The game will lake a few moments to start up
and you will be ready to begin plaving. If you have plaved Duke Nukem'™ 3D,
Shadow Warrior will be familiar 1o you If you have not plaved Duke Nukem 3D, we
recommend reading the rest of this manual thoroughly to familiarize yoursclf with
the controls and options available in this program,




ABUUT UPTIMIZING PERFURMANCE

Shadow Warrior should work well with any Macinlosh or Macintosh-compaltible compulter
If the game is not performing well for you, please look over this section or the
Optimizing Perfarmance section on page 25 of this manual. This is especially important
if vou have an colder mechine or a machine with 16MB of RAM.

. If your computer has only I6MB of RAM, adding more memory is the single bost wa,
to mnake the game run faster. Memory is extremely inexpensive at the time of this writing
and increasing your available RAM will make all of your programs run better. It purchas-
ing RAM is impractical for you, you may use Virtual Memory to increase the memory
available to the program. Consull your Macintosh owner’s manual for Virtual Memory

instructions.

2. )f the game seems to run slowly or the mation is jerky, you may adjust various graph-
ics and sound parameters from the Options menu within the game Graphics Options
allow you to chenge the resolution, detall level, view size, and brightness of the game
display.

ABUUT INTERNET PLAY

Due o the large amounts of information Shadow Warrior needs to send in @ network
game, Shadow warrior should not be played with more than two people over the internet
without 8 56.6K modem or an ISDN or Tl link o the internct. Play with slower modems
is possible but not recommended due to decreased performance. Head-to-head, one-an-
one play should work well with a 288K or 33,6K modem.



| PURYING SHADUID IUMUUIIR

.ﬁ . THE MAIN MENU

. Fram the main menu, yvou can select:

NEW GAME - Start a game.

(FEN GAME - Continue vour batlle

™ SAVE GAME - Hedge your bets,

. OPTIONS - Configure the gane.
CREDITS - Bow lo your maslers.
QUIT - Resume vour life.

L THE OPTIONS MENU

Allows you to choose from several usehd s v

" diglog boxes. :
GRAPHICLS - Set up size of screen =yt
and more. e 7

M e lanes o

SOUND - Toggles sound/music and vol- u T I .1*
yimes.
CONTROLS - Conhigure your contrals.




MISCELLANEOUS - Set the following options.

MESSAGES - Toggles on screen messages.
AUTO RUN - Makes Lo Wang run &l the time,
CROSSHAIR - Makes aiming casier.
LEVEL STATS - Shows the number of secrels found and enemies killed.
AUTO AIMING - Makes t casier o hit enemies.
HIDE AIR/BOSS METERS - Turns off these melers,
You can also set options by wsing the Options menu in the menu bar. This menu has
two funclions not available from the Main Menu.
PLAY RECORDING... - Allows vou o replay a recording from the game.
KID MODE - Shadow Warrior can gel pretty violent and this mode allows
parents to Jock out questionable material from their children
with a password.

You can also use the File menu to save or load games, as well as open any new maps
you may find on the Internct.




SAVING AND LOADING GAMES

You can bring up the Main Menu at any
f time during gameplay by pressing [Esc].
. Fram there vou can save the aurrent

| game or load a previously saved game.

You can also press [F2] during gameplay
lo save the current game, or [F3] to load

a previously saved gaine. : :'L:;ii

WHERE AM I (The Automap)
By pressing [TAB] during the game, you
can see where you arc in the game.
Pressing the [TAB] key multiple times
% will toggle wire frame, or solid maps.

* While in map mode, you can zoom in
and out of the map with the "+" and "-"
keys. Pressing the "F" key will turn an
“fallow made” and vou can see more of

the map around you.




THE STATUS BAR

During gameplay, the status bar at the boltom of the screen reveals vital information.
If vou cannot see the status bar on your screen, use the + and - keys to resize t
(Press the [FI] in game for mare info). Here is a description of the items in the sta-
bus bar, from left to night:

HEALTH Shows Lo Wang's health level. If this drops to zero, you're dead,
ARMOR Shows the percentage of Lo Wang's armor remaining.

WEAPONS Shows the status of Lo Wang's weapons. Each weapon displays two num-- g
bers separated by a /. The first number is the amount of ammo vou have for that
weapon, and the second is the max amount of ammo possible for that weapon. If the i
numbers are brightly It this means t is the currently selected weapon. 1f it isof
medium brightness, it means you have the weapon, but # is not currently sdected. I

it is dark, t means you have not found that weapon yet.

AMMO Shows the amount of amma left for the currently sclected weapan,

INV Shows the percentage and status (if applicable) of the currently selected

inventory ftem. To change the currently sdected item, use either the “[T or "] key.

KEYS Shows the kevs currently in your possession,

ﬂn..r-.'
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| U JJANG'S WERPONS

I Pressing the weaspon's number (keys 10 on yvour keyboard) during gameplay activates
P the corresponding weapon, unless you don't have & or  is out of ammo. Weapons
. | €an be recharged with ammo found scattered around the leveks.

l. Katana/Fists of Fury (Key | toggles modes):

Mode & The Kalana is a powerhul weapon that can slice right through
the lower ninjas. :

Mode & You can also use vour powerful Fighting skills at dose range
o punch the life out of your cnemics.

small hand held “stars” that you throw at enemies. You throw three at
a time, 50 you must have three or more in your possession to use,

3. Riot Gun - Quad barrel sholgun (Key 3 toggles modes):
Mode | You shoot a concentrated blast through ene barrd that will
knock an encrmy off his feel.

Mode 2 You fire all four barrels, with a wider spread.

4. UZ (Key 4):
Armed with your high speed machine gun, you become even more

deadly than before If you pick up a second UZI, you can wield two
at the same time.



5. Rocket Launcher (Key 5 toggles modes):
Mode | (Normal Mode): You shoot explosive rockets,

Mode 2 (Heat Secker Card needed): Your next five rockels are
heat seekers.

Mode 3 (Nuke needed): After a short countdown, fire and find
cover.. or you will glow.

6. Grenade Launcher (Key 6):

Launches a 40mm explosive shell that bounces before it explodes. It
is ideal for dealing death in hard-to-reach places such as ledges or
around corners.

7. Sticky Mines (Key 7)

Perhaps the sncakiest weapon in Lo Wang's arsenal, this smal
explosive device is surrounded by sharp spikes, allowing it to “stick”
to almost any surface. After priming, the bomb will detonale when its
motion detectors sense something nearby.

8. Rail Gun (Key 8):

A top secret weapon and still classified, the Rail Gun can shoot a
piece of metal at near light speed, propelled by a magnetic ficld.

9. Guardian head: (Key 9 toggles modes):

With three modes of firing, all involving fire, this weapon is devastat-
ing in the right hands.

10. Ripper Heart {:Kﬂ)" 0):

Squeezing this gory tem will summon forth a "zombie-like
version of Lo Wang, that will kill with reckless abandon for
a short time,




ITEMS

f These itemns arc used immediately when touched, and cannot be stored for later use
Armor: Red Armor adds 100%; Gray Armor adds 50

Fortune Coolde: Not only does it come with a dever litte
message inside, but it also gives Lo Wang a 50% health boost,
up to & maximum of 200%.

Small Medkit: This handy liltlc discovery adds 20% to vour health,
up to & maximum of 100%,

Hest Seeker Card: This small red circuit board allows your next five
missiles 1o have heat-seeking abilities. (For use with Rocket Launcher)

The Nuke: Once found and delonated, it will cause o range of
destruction thet only the strongest enemies can hope to survive. All
athers will be vaporized. (For use with Rocket Launcher).

Keys: You will discaver both ancient and modem keys that you will
need to advance through the levels.
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INVENTURY ITEMS

Unlike other items, inventory items are kept until you sdect and use them. They are
accessed through cither hotkeys (detailed below) or through the inventory gstem
keys "[' and "7,

a sclected ftem.

which scroll through vour available ftems. Press [Return] to activate

Gas Bomb (Fres Gk Once dropped, it temporarily emits @ stream
aof choking smoke This is a good way to dear out a room full of
monsters, or block a crtical ftem in 1nul’tip}.¢1}=.

Smoke Bomb (Press §¢ Renders you partially invisible for a few
seconds. During this time you can dispatch monsters more casily B

Flash Bomb (Pres Fx Blinds nuurb} encmics for a few seconds, and
while they stumble about, you can sneek by or finish them off.

Caltrops (Press € Small razor sharp talons of melallic death You
throw the Caltrops on the floor, and they lie there IF someone steps
on them, they lake some damage, and they will cry out in pam.

Night Vision Goggles (Press Nt These government issue goggles can
iHluminate living things in the darkest of areas. It's best lo save these
for the dark gloomy areas of your adventure.

Large Medkit (Pres M) A portable health pack, carrying a maxi-
mum of 100% additional health When vou are low on health, you
can select this to bring your health back up.

Tod Kit: Allows you to repair damaged vehicles like tanks, farklifts
or other broken machinery you find along the way. You achivate the
kit by pressing SPACE/OPEN on the contrd panel of a broken vehi-
cle (usually indicated by rising steam).



| ENEMTES/HAZARDS

Brown Ninja: Can do all player actions (dimb, duck, hide behind
boxes). Fires an UZl or throws shurikens Will suicide from lack of
hanor.

Red Ninja: Can do everything his brown counterpart does, plus he
can shoot small rockets at vou.

Green Ninja: Fires UZl or Wwo different forms of magical napalm.
Can Flash bomb vou, and is always partially invisible until he dies.
Orange Ninja: Have the added ability to shoot heat seeking rockets al
you, and are lougher than normal,

Gray Ninja: Have the abil Tv to launeh grenades at you, and are
lougher than normal. |

Shadow Ninja: The most Fearsaine of the lok this Ninja uses ancient
skills to stay almost invisible. He can blast you with bwa types of
magic napalm, or use blinding flash bombs on you.

Coolie: Walks around with a box of explosives Poses Tttle threat form
a distance, but if he gets near you, he blows up, causing severe damage,

Coolie Ghost: Not content with altacking you once, some Coalies will
spawn a spectral ghost after they make their ultimate sacrifice. These
apparitions float around phasing in and out of exstence, taking time
out to heave nasly gobs of bloody goo at you.

Ripper:  big apc-like monster. Jumps around, can ding to walls above
you, waiting to drop at any moment. Or they will charge vou at full
speed and start ripping at your flesh Will rip your heart out if vou
let him get too close.




Baby Rippers: These arc smaller / taster versions of their parents,
only they move faster, spit green goo and are very hungry.
Guardian: These hard to kill beasts use swords al short range, switch-

ing to firchalls when farther away. Note Sometimes after kalling one,
you can harvest its decapitated head and use it as a weapon.

Female Ninja: These female warriors carry a lethal crossbow, and
vou will find yoursell dodging bolts from long distances When they
get closer they will loft sticky mines in vour direction, making # hard
to stand still. Treat these ladics with some respect.

Koi: These denizens of the deep look like norma KOI until you gel
close and notice the rows and rows of razor-sharp teeth. Along they
pose little threal, but if you come across a school, you'd better make
a run for dry ground.

Hornets: These overgrown yellow jackets will do minor damage.
but beware a swann of them, They are extremely fast and ervatic
moving, making them hard lo hit, while they continually sting away
at your health,

Bunnies: You may encounter some of these cute little creatures
along the way. What you do with them is your business.

Mines: There are various mines n the game that will detonate
near you. They can spew caltrops, spew poison gas, explode
launch grenades, or Hash bomb you There are also ancient
magical counterparts to mines called Accursed Heads.
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BUSSES/MINT BUSSES

Serpent God: This is a four-armed evil snake-like creation of Zilla
himself, He can shoot devastating energy balls from his eves, and
when attacked, will spawn a arcle of exploding Accursed Heads.
Ihese heads will launch themselves at in order o protect their evil
mastcr. Be very prepared for battle when you mect a Serpent God.

Sumo: This giant tghlmﬂre. of a suno wrestler will meet you with a
vengeance. His mass alone will cause damage as he stomps on the
ground, sending shock waves your way, He can also send Accursed
Heads your way with a giant clap af his hands. These guys are ven
tough, and hold & surprise or twa for you.

Zilla: Your final battle of the game Prepare well, Lo Wang, and heed
all that Master Leep has taught you.




(D-RUM CONTROU

CD-ROM contral lets you listen to your favorite audio CD as you play. Press the

letter "T" during gameplay to display the command line interface, where you can
enter commands and cheat codes The following commands apply to CD contral,

ed on: Re-enables the CD audio system after a "od off" command.
o off: Shuts down the CD audio system.

cd resek Rescls the CD audio. This is uselul if you change CDs or insert the €D after
you ve already run Shadow Warrior.

cd play <track number>: Plays the specified track one time.cd loop <drack numbers:
Plays the specified track repeatedly until # is manually stopped or another track is
started.

cd stop: Stops the currently plaving track.

cd resume: Resumes playback of a stopped track.

cd eject: Ejects the CD (for CD plavers that do not have a manual eject button).
cd remap <rackl> <rack?> <etc: Lets you specify the order in which eudio tracks

arc played. If the CD audio system is told to play track I, it will instead play the st =
track you specified.

cd info:Reports information such as the number and types of tracks on the current

CD, what track (if any) is currently playing, and the playback volume.




MUUTIPLAYER GAMES (ANGBANG)

To start a multiplayer game of Shadow Warrior, run "Sw Net Startup™ and select

fram the following aptions.

NETWORK GAMES

. Double-click the “SW Net Startup” icon. Select IPX, Appletalk, or TCP/IP
from the Shadaw Warrior Network Setup menu. If you do not know whether your
nehwork is 1PX, App etalk {ethernet), ar TCP/IP consull with your System
Administrator.

2. Select the number of players (2-8) and select 4 “Player Name” # you like.

3. Click an the Start button {we recammend E..cwung the. Options at their defaults
uniem you encounter a problem).

. The game will "look” for all the players and stark.

.HOI]EH GAMES | |
. Double-click the “SW Net Startup” icon. Select Modem fram the Shadow Warrior

Nehwork Setup menu.
2. Llick on the Modem Options button and select whether you will Wait for Call or
Dial up opponent. Choose a player name and dick Start.
3. When the Conneclion Settings menu is displayed, choesc the correct scttings tfor
your modem. Click OK.




SERIAL GAMES

. Double<click the "SW Net Startup” icon. Select either Appletalk or
Serial from the Shadow Warrior Network Setup menu, depending on which kind
of connection you are using.

2. Under “Player Name”, enter a new name for yourself if you like.
3. Click the Start button.
4. The serial initialization will begin, followed by Shadow Warrior.

REMOTERIDICULE™

RemoteRidicule is used to "aunt” your opponent(s) during WangBang.

By pressing [Command] - FIFIO during play, your oppanents will hear your taunts,
These sounds come from the taunts folder. You can replace the taunts in the folder
with new files, st make sure that everyone has the same files.

SENDING MESSAGES DURING MULTIPLAY 4
You will need to “chal” with vour opponents while pi.ga:.ing WangBang. You can do Sﬂby |
pressing “T” during play, then typing a message to them. s a good way to laugh at
their pitiful play, or sugged a new levd lo try. Say what you want, we're not the FCCL 4
MULTIPLAYER OPTIONS i
(once inside Shadow Warrior)

The following multiplay options are available in Shadow Warrior:

Game Type: The three options arc WangBang, WangBang [No Spawn], and
Cooperative. Cooperative is a way of plaving "against the game”. WangBang
means you and your buddies just blast each other! A WangBang game with no
spawn means some items do nol come back after having been taken.

Level: This slidebar allows you to sclect which level to play in.

1o



Markers: Show respawn markers that "mark” the spot where an tem will respawn.
Kill Limit: Select a kill imit to play to.
¢ Time Limit: Select a time limit to play to.

Player Color: You can choose pants color with this. NOTE When using team play,
this is how you determine teams. Make sure that # you are playing in team mode,
that your team chooses the same pants color,

Other Options: There are four more options available under the

"Other Options” menu. They are:

Mansters: You can. m no monsters, or three levels of monster difficully,

Team Play: You can play in leams The way 1o tell who is on a team is by

the Gﬁﬂf of ﬁ'ﬂ pﬂﬁi& Sﬂlﬂcfﬂi Make sure thet all players on the same team have the
same pants af.llur lf vou select CoOp play, this option is

not available,

Hurt Tmuh: If this is sclected, you can hurl your own ic:mnmﬂ’tn or your friend
if you are Iiaymg CoOp.

Play w/Nuke: I you wish to disable the "Nuke" weapon you can do # here.
Start Game: Eh:e the pﬂramx.hra have been selected, this starts the gamc!
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JOYSTICK

GAMEPAD

KEYBOARD

CONTRUWNG 0 JDANG

You can get a complete listing of the default keys by pressing the FI key during
gameplay. The following is a bst of the basic moves:

Mavement Direction

Button | Fires the selecled weapon

Button 2 Strale it

Button 3 Run
Movement Direction e
Bulbon | = Fires the selected weapon i
Button 2 Strafe : i
Button 3 Run ﬂ;j::“;-ﬁ'-
Button 4 Use items or open door w
Arrows FoMovement: .{
Spacebar Use items or open doors

Tah 20 map modes

Shit + Arrow Run in_dircchion of arrow key

Caps Lock Auto run L

Cmd + Arrow Strafe in direction of arrgw key

e

Crouch

I80° Turn

Select inventory item

S e

Use current inventary ttem




Callrops
Flash Bomb

Gas Bomb

Medkit

Night Vision

sinoke Bomb

Weapons selection

Previows weapon or next weapon
olster weapon

=
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iT&'ﬂ a screen shot
W for Shadow Warrior play
J-FIB lfjemuhﬂidmu}ﬂ using presel sounds
Send pre-defined Macro Messages
Tvpe a message to everyane
See Co-Op view




TECHNITAL SUPPORT (U.S. & CANADM)

I} you experience problems running or playing this produch, you can use anw of the
following avenues to obtain assistance:

Assistance Via World Wide Web

Get up-to-the-minute technical information at the MacSoft web-site:

h‘r’[p:f www. wizworks.com/macsofl

Intarmabion is available 24 hours a dav, seven davs a wedk. You'll have access to our FA( )
documents, (Frequently Asked Questions) which ‘contain our latest troubleshaoting infarma-
tion. You can also visit an E-Maill arca where you can Jeave us your lech support problems
and questions, and other areas where you can get valuable information on MacSoft and 6T
Interactive Software products. ' ;

P,
i} Ca e

Help Via Telephone

For phone assistance, call MacSoft's Tech Support st 612-559-5301. We are available e
Monday through Friday, 9 AM until 5PM (CST). Please note that live Tech Support may be
closed on major holidays. We ask that you do the fnllmuina when calling: be st your =
computer; have your swstem information ready for our lechnicians im_ll_u:iu'ug: :;k-}[r:m

make and model, RAM, and any screen or error messages vou've encountered; it wall
expedite your handling significantly.

Help Vie Mail :
In the event our technicians determine that vou will need to forward materials directly lo
us, picase include a brief letter explaining your problem. Please also include your tele
phgl’tu number in case we need lo call you Your mail should be sent to the following
agdress:

Machott
Altre Technical Support _
2300 Berkshire Lane N g
Minncapolis. MN  5544|
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OPTIMIZING PERFORMANCE

Shadow Warrior is designed to gel the most out of your computer, but sometimes #
needs a little help, There are several paramelers you can adjust to improve the perfor-
mance of Shadow Warrior on your computer.

Memory: The performance of Shadow Warrior can be grestly improved by increasing the
amount of memaory available to the program. It you have only |6MB of RAM installed in
your computer, please consider that purchasing more RAM is the single best way 1o
imprave the perfarmance of Shadow Warrior and many other programs. RAM may be
purchased via mail-order catalogs, over the faternct, or directly from vour retailer and is
now cheaper then ever. Allernatively, vou may also make more memory available to
Shadow Warrior by Wening off unnceded cxlcnsions in your Extensions Manager control
puncl. If this still does not free nnﬂugh RAM, you will need o tum on Virtual Memory in
your Memory conted panel. For more information on ﬁ'h‘: Extensions Manager, Virtual
Memory, and your Memary control pam..l p]:..dht. mrisuﬂ the HELIT"h'I.':h User's Guide which
came with your computer. : i

Grap:i'm:s Options: The Graphics OPhcms ren in hhaﬂﬁw %rﬂar ‘adjusts various graph-
ics settings from within the geme To access this menu. chogse Options from the Main
Menu in Shadow Warrior, then choose Graphics from the next menu which appears The
| First option, Screen Size, adjusts the gume dusp!&y lo mach your munitor’s resolution. 1f a
chaice is not available (greved oul) thal screen size will not work on your monitor. The
larger the screen size vou choose, the betler the game will laok on vour monitor, the
smaller the sereen size the better the game will run. Find the sctting which works best
for vou. The Detail Level option increases or decreases the resolution of cach individual
graphic on vour screen The High selting provides extremely crisp graphics, but makes
the game perform slowly on any but the fastest machines, Medium is the standard set-
ting, with good detail and good performance. Low is the paorest visually, bt greatly
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enhances the speed of the game Skip Odd Lines makes the computer draw only half the
horizontal lines on your monitor than it would otherwise. Test this setting to see the dif
ferance; colors are less intense, but the game performs quite a bit faster with this option
chosen. View Size adjusts the size of the gameplay window, as opposed to the size of the
whole display (sec Screen Size above). The smaller the view size, the faster the game will i
run. Brightness adjusts the amount of light and darkness in the display, making the colors i‘b—c

y

more  intense ot look more washed out. Border Tile adjusts the border around the
screen. These last bvo can be set to your personal preference. Shadows lets vou decide
whether Lo Wang end his cnemies cast shadews on the ground. Turning this off Improves
game speed sumewhal

Sound Ophﬂﬂi The Sound Options menu ﬂd]uah the volumes and guality of your e
sounds and music, Sound allows you lo turn off the sound cliects complelely (with the 1“‘
checkbox] and adjust the volume with the slider bar. The farther vou drag the slider to 3
the right, the louder the sound effects will be. Turning sound effects off is o last-ditch

option for improving performance, The Music sctting works in much the same way.

Ambience turns on and off the variows background naises heard in the game (machines
humming, waterfalls crashing, airplancs rushing overhead, elc) Turning Ambience of]

can improve game performance. “Boss Music” toggles whether the special music is

palyed for the big enemies Turping it off can improve pﬂl‘fﬂl‘mﬂﬁt.r: while fighting par-

ticularly tough monsters. Flip Stereo reverses the lebt and right channels of the sound

effects. Choose this checkbox i it scems that sounds which shawld be coming from the

left arc coming from the right and wice versa. (Whether you nced to do this depends on

the kind of speakers you ere using.)

With same cxperimentation you will find the right balance of adjustments to make

Shadow Warrior run well an your machine. You may wish 1o cxamine the file “SW Mac

Read Me™ in the "Shadow Warrior™ folder for any additional information about oplimiz

ing performance. This filc contains all the Jatest information vou may need about vour
copy of Shadow Warrior,
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Published by MacSoft

Copyright 1997 by 3D Realms, Incorpurated. All worldwide rights reserved by 3D Realins,
Incarporated. Lo Wang and any likeness are trademarks of 3D Realms Entertainment,

lne Marketed and distributed in North America under license by the WizardWorks Group,
Inc. Na part of this documentation may be reproduced, transmitted, transcribed. stored in
any retricval system, or translated into any language without the written permission of 3D
Realms, Incorporaled and WizardWorks Group, Inc.

The disks provided with this product may not be reproduced or duplicated in any form
whatsoever, except fo supply a single backup topy for the personal use of the purchascr.

Macintosh i:‘._;ﬂ r::_g_ia:tgmd trademark of Appiﬂ L'mnpqh.-r, Inc.

Coe G . Limited Warranlty
WizardWarks warrants that the media on which this sofbware is distributed, as well as the
asccompanying documentation, are free from defects in malterials and workmanship.
Wizurci;Wﬂrkﬁ will replace defective media or documentation free of ch}@. if you return
the defective media or documentation with proof of purchase to WizardWorks within 90
days after you purchased the product. : e gt

WizardWorks Group, Inc. mekes no warranty or representation, cither cxpress or implied,
with respect lo the software, its quality, ps::ffﬁrmance. merchantabilily. or fitness for any
particular purﬁvse. As a resull, this sottware is sold "as is” and the purchaser assumes the
entirc risk s to its quality and performance. In no event will WizardWorks be liable for
dircct, indirecl, special, incidental, or consequential damages resulting from any defect in
the sofbware ar its documentation. even if advised of the possibility of such damages.
Wigr;cdi-"\‘h.fur!g:; alst raserves the right to alter or delete’any product specification stated or
impli :

The warranty described aboyve is the exclugive warranty for this product Mo other warran
by, express or implied, & offércd for this product.
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Macoft is committed to bringing you the finest software al reasonable prices We hope you enjo i
this game and welcome vour comments on this or any of our products We can be reached by mail e
at: .ﬁ‘
Macdofl
An alfiliate of GT Interactive
2300 Berkshire Lane North
Minneapolis, MN 5544|

PLEASE DONT MAKE ILLEGAL COPIES OF THIS SOFTWARE

Shadow Warrior was produced through the efforts of many people with bills to pay and
averpriced apartments to rent, Please, dont make illegal copies for others who have nat
paid for the nght to use the program.

F'his program is protected by federal end international copyright. To repart copyright i
violations o the Software Publishers Association call [-800-388-PIRE or write: e

sobtware Publishers Association
730 M St NW Suite 700
Washington, DL 20036 4510

Fax: | 2002 223 B756
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